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Introduction

Eclipse Rich Client Platform (RCP) has become the leading open development platform,
capturing close to 70% of the open integrated development environment (IDE) market. I
wrote this book to give you a clear and technical guide to Eclipse development, and to help
you achieve your goals quickly. If you use Eclipse, you must become familiar with RCP. It
gives you all the tools you need to build commercial-quality applications and deploy them
quickly, thus saving time and increasing the return on investment.

In Practical Eclipse Rich Client Platform Projects, I explain the necessary technical concepts
approachably, with plenty of source code and images, in a detailed and engaging (I hope) way.
This book will show you how to apply modern graphical user interface (GUI) concepts to your
applications using real-world examples. Each chapter explains the concepts carefully, and then
puts them to the test with a hands-on exercise.

We start with the architecture and foundations of Eclipse RCP, taking a tour of Equinox,
the core platform, Standard Widget Toolkit (SWT), and the Eclipse IDE workbench. Next, you
learn about the details of the plug-in architecture, always with a focus on RCP components:
perspectives, advisor classes, basic branding, and product configuration. In Chapter 4, we look
at common concurrency concepts used in modern GUI development with the Jobs API: job
classes, scheduling rules, resource management, and more.

In Chapter 5, you learn how to spice up your GUI with the powerful Forms API. Among the
areas covered are look and feel, form controls, and advanced topics—in short, everything you
need to improve the look of your RCP application.

A good help system is an important component of any application. Chapter 6 tackles
this subject with detailed descriptions of how to build your help files, required help plug-ins,
dependencies, and configuration.

If you ever work on graphics-enabled applications, you will find Chapters 7 and 8 of spe-
cial interest. They cover 2D and 3D graphics in depth. In the 2D arena, you learn how to use
Draw2D, Graphical Editing Framework (GEF), and the Zest visualization toolkit. If 3D is your
thing, you’ll want to take a look at how OpenGL can be used to build a powerful Earth naviga-
tor (Google style) in a snap.

Chapter 9 shows you how to create powerful reports using the Business Intelligence and
Report Toolkit (BIRT), which you will find particularly useful if your application is targeted to a
business environment.

Finally, Chapter 10 explains how to pack your work and deploy it automatically to an
update site using the automated build system.

Practical Eclipse Rich Client Projects covers all the major needs of a modern application.

It will help you get things done. If you are interested in the source code, you can download it
from this book’s details page at the Apress web site (http://www.apress.com).

Xv



CHAPTER 1

Foundations of Eclipse RCP

The Eclipse philosophy is simple and has been critical to its success. The Eclipse Platform
was designed from the ground up as an integration framework for development tools. Eclipse
also enables developers to easily extend products built on it with the latest object-oriented
technologies.

Although Eclipse was designed to serve as an open development platform, it is architected
so that its components can be used to build just about any client application. The minimal set
of modules needed to build a rich client is collectively known as the Rich Client Platform (RCP).

This chapter focuses on the foundations of RCP. It begins with a summary of the benefits
of Eclipse, and then discusses the architecture of RCP. Finally, you’ll work through a practical
exercise that demonstrates the power of this dynamic modular technology.

Benefits of Eclipse

Eclipse is an integrated development environment (IDE) written primarily in Java. However, it
goes well beyond a Java development platform in the following ways:

e Itis open and extensible. Extensible software can function as a component of a larger
system. Eclipse’s openness permits greater interoperability, opportunity, and choice.

e It provides multilanguage support. Eclipse supports an army of programming lan-
guages, including Java, Java Platform, Enterprise Edition (Java EE), Aspect], C/C++,
Ruby, Perl, COBOL, and many others.

¢ It provides a consistent feature set across all platforms. This allows developers to con-
centrate on the problem rather than the specific platform. More important, it functions
the same way on each of these platforms.

e It provides a native look and feel, which is required by today’s professional applications.

e Avery active community is willing to help with any problem. Moreover, since Eclipse
is the foundation for a number of commercial software products, many vendors offer
additional support.

¢ Eclipse is at the forefront of the software tools industry. This means that you can
depend on it as a viable, industrial-strength tool for the foreseeable future.
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The bottom line is that Eclipse is extensible, configurable, free, and fully supported. It
is so well designed for these purposes that many developers find it a pleasure to work with.
Newcomers from other languages, especially C/C++ on Unix, will discover this after learning
the basics.

How Is RCP Different from the Eclipse Workbench?

Many people struggle to understand the difference between the Eclipse IDE workbench and
RCP. The answer is simple: there is no difference—well almost no difference. Both are based
on a dynamic plug-in model, and the user interface (UI) for the workbench and RCP is built
using the same toolkits and extension points. However, RCP has the following distinguishing
features:

¢ In RCP, the layout and function of the Eclipse IDE workbench is under fine-grained
control of the plug-in developer. In fact, the Eclipse IDE workbench itself is an RCP
application for software development. Here is where the line between these two
becomes thin.

¢ In RCP, the developer is responsible for defining the application and customizing the
look and feel of the Eclipse IDE workbench to fit the needs of the application.

e In RCP, the platform application needs only the plug-ins org.eclipse.ui and
org.eclipse.core runtime to run. However, RCP applications are free to use any
platform plug-ins they need to provide their feature set.

Eclipse RCP Architecture

RCP employs a lightweight software component framework based on plug-ins. This architec-
ture provides extensibility and seamless integration. Everything in RCP (and Eclipse, for that
matter), with the exception of the runtime kernel, is a plug-in. It could be said that all features
are created equal, as each plug-in integrates with Eclipse in exactly the same way. A plug-in
can be anything: a dialog, a view, a web browser, a database explorer, a project explorer, and
so forth.

RCP is architected so that its components can be put together to build just about any cli-
ent application using a dynamic plug-in model, toolkits, and extension points. The layout and
function of the workbench is under the fine-grained control of the plug-in developer. Under
the covers, the following components constitute RCP:

e Equinox

¢ Core platform

¢ Standard Widget Toolkit
¢ JFace

¢ Eclipse IDE workbench

Let’s take a closer look at each of these components.
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Equinox OSGi

According to its developers, OSGi! is a dynamic module system for Java. OSGi was designed as
a technology to tackle software complexity created by monolithic software products. Its focus
is the development of new software, as well as the integration of existing software into new
systems. By providing standards for the integration of software, the OSGi framework improves
reusability and reliability, and reduces development costs.

At its core, OSGi provides a software framework that allows applications to be con-
structed from small, reusable, and collaborative components. These components, in turn,
can be included in a bigger application and deployed.

Equinox is Eclipse’s implementation of the OSGi framework. It defines an application life-
cycle management model, a service registry, an execution environment, and modules. On top
of this framework, a large number of OSGi layers, application program interfaces (APIs), and
services have been defined.

An important concept in the OSGi framework is the bundle. A bundle is a dynamic com-
ponent that can be remotely installed, started, stopped, updated, and uninstalled without
requiring a reboot.

Life-cycle management is done via APIs, which allow for remote downloading of manage-
ment policies. Such a dynamic component model is missing from today’s stand-alone Java
Virtual Machine JVM) environments.

OSGi provides a powerful dynamic component model, which is why the Eclipse Founda-
tion selected it as the underlying runtime for Eclipse RCP and the IDE.

Core Platform

The core platform includes a runtime engine that starts the platform base and dynamically
discovers and runs plug-ins.

Core Platform Responsibilities

The core platform is responsible for the following:

¢ Defining a structure for plug-ins and the implementation details: bundles and class-
loaders

¢ Finding and executing the main application, and maintaining a registry of plug-ins,
their extensions, and extension points

¢ Providing miscellaneous utilities, such as logging, debug trace options, adapters, a
preference store, and a concurrency infrastructure

The runtime is defined by the plug-ins org.eclipse.osgi and org.eclipse.core.runtime
on which all other plug-ins depend. It effectively holds all the pieces together.

1. OSGi originally stood for Open Services Gateway initiative, but that name is now obsolete. Visit
http://www.osgi.org for more information about OSGi.
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Note Because plug-ins are implemented using the 0SGi framework, a plug-in is essentially the same
thing as an 0SGi bundle. | will use these terms interchangeably, unless discussing particular framework
classes.

Runtime Plug-in Model

The plug-in model is structured around the following concepts:

Plug-in: A plug-in is a structured bundle of code and/or data that contributes functional-
ity to the system. Some plug-ins can contribute to the UI using an extension point model.
Others supply class libraries that can be used to implement system extensions.

Extension points: An extension point is a well-defined place where other plug-ins can add
functionality. Plug-ins can add extensions to the platform by implementing an extension
point. Defining an extension point can be thought of as defining an API, with the differ-
ence that the extension point is declared in Extensible Markup Language (XML) instead
of code.

OSGi manifest and plug-in manifest: These manifests allow the plug-in to describe itself to
the system. The extensions and extension points are declared in the plug-in manifest file,
which is called plugin.xml. The platform maintains a registry of installed plug-ins and the
functions they provide in the MANIFEST.MF file.

Dynamic loading: In the OSGi services model, software bundles do not pay a memory or
performance penalty for components that are installed but not used. A plug-in can be
installed and added to the registry, but it will not be activated unless a function that it
provides is requested at runtime.

Resource management: Resources within the user’s workspace are managed by the plug-

in org.eclipse.core.resources. This plug-in provides services for accessing the projects,
folders, and files stored in the user’s workspace or alternate file systems, such as network
file systems or a database. This plug-in is most useful for Eclipse IDE applications.

The overall philosophy of the core platform revolves around the idea of building plug-ins
to extend the system. For example, the Eclipse Software Development Kit (SDK) includes the
basic platform plus two major tools: the full-featured Java development tools (JDT) and a
Plug-in Developer Environment (PDE) to facilitate the development of plug-ins and exten-
sions. These tools provide an example of how new tools can be composed by building plug-ins
that extend the system.

Standard Widget Toolkit

The Standard Widget Toolkit (SWT) is the graphical widget toolkit used by Eclipse. Originally
developed by IBM, it was created to overcome the limitations of the Swing graphical user
interface (GUI) toolkit introduced by Sun. Swing is 100% Java and employs a lowest common
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denominator to draw its components by using Java 2D to call low-level operating system prim-
itives. SWT, on the other hand, implements a common widget layer with fast native access to
multiple platforms.

SWT’s goal is to provide a common API, but avoid the lowest common denominator prob-
lem typical of other portable GUI toolkits. SWT was designed for the following:

Performance: SWT claims higher performance and responsiveness, and lower system
resource usage than Swing.?

Native look and feel: Because SWT is a wrapper around native window systems such as
GTK+ and Motif, SWT widgets have the exact same look and feel as native ones. This is in
contrast to the Swing toolkit, where widgets are close copies of native ones. This is clearly
evident just by looking at Swing applications.

Extensibility: Critics of SWT may claim that the use of native code does not allow for easy
inheritance and hurts extensibility. However, both Swing and SWT support writing new
widgets using Java code only.

Perhaps a shortcoming is that, unlike Swing, SWT requires manual object deallocation, as
opposed to the standard automatic garbage collection of Swing. SWT objects must be explic-
itly disposed of; otherwise, memory leaks or other unintended behavior may result. This is due
to the native nature of SWT, as widgets are not tracked by the JVM, which is unable to garbage-
collect them. Some claim that this increases development time and costs for the average Java
developer. But the truth of the matter is that the only SWT objects a developer must explicitly
dispose of are the subclasses of Image, Color, and Font objects.

JFace

JFace is a window-system-independent GUI toolkit for handling many common programming
tasks. JFace is designed to work with SWT without hiding it, and implements a model-view-
controller (MVC) architecture.

The following are some of the UI components in JFace:

¢ Image and font registries
e Text, dialog, preference, and wizard frameworks
e Viewers
e Actions
Viewers are used to simplify the interaction between an underlying data model and the
widgets used to present that model. Table and tree viewers are the most typical examples.
Actions are essential for the developer. They may fire when a toolbar button or a menu

item is clicked or when a defined key sequence is invoked. They are most useful when contrib-
uted to the workbench declaratively in plugin.xml.

2. See “Why I choose SWT against Swing” (November 19, 2004), on Ozgur Akan’s blog. (http://weblogs.
java.net/blog/aiqa/archive/2004/11/why_i_choose_sw.html).
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The Eclipse Workbench

The Eclipse IDE workbench is the basic development environment in Eclipse. It is built around
the following concepts:

Perspectives: A perspective defines the initial set and layout of the views in your work-
bench window. Perspectives are focused on a specific development task, such as Java,
Java EE, plug-in, and so on.

Views: Views are the small windows and sidebars around the edges of the workbench.
Views are used to navigate the workbench and present information in different ways.

Editors: Editors are used to do the actual coding. For example, you might use editors
to code in Java, JavaScript, Hypertext Markup Language (HTML), or Cascading Style
Sheets (CSS).

Workspaces: A workspace is the disk folder where the actual work will be stored.

Projects: A project is a container used by the workbench to group associated folders
and files.

Note All the exercises in this book were written using Eclipse 3.4 (Ganymede). This is important, as the Ul
is somewhat different from that of version 3.3.

Hands-on Exercise: Getting Your Feet Wet with the
0SGi Console

Programming with Eclipse can be thought of as a game. The more you practice, the better you
get at it. The goal of this exercise is to get you started by building a plug-in project that uses the
OSGi console. We'll go beyond of the typical Hello World example.

In this exercise, you will write a plug-in to embed a tiny Jetty web server that uses Equinox
to define a simple servlet class that returns the headers of the HTTP request. This plug-in will use
the extension point org.eclipse.equinox.http.registry.servlets to define the servlet alias
/servlet1, which will be accessed through the browser as http://localhost:8080/servlet1.

Starting a New Plug-in Project

Starting a new plug-in project is easy with the Plug-in Project wizard.

1. From the Eclipse IDE main menu, select File » New Project (or click the New Project
icon on the toolbar) and choose Plug-in Project, as shown in Figure 1-1. Then click Next.

2. Enter a project name and use the default target platform, as shown in Figure 1-2. Click
Next to continue.
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Figure 1-2. Naming and targeting the plug-in project
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3. Enter the plug-in information. The plug-in ID uniquely identifies the plug-in within

the core runtime. In the Plug-in Options section, you need to choose to generate an
activator class to control the plug-in life cycle. Leave the option “This plug-in will make
contributions to the UI” unchecked, as the plug-in will not display a UL You do not

want to create a rich client application, so leave the final option set to No, as shown in
Figure 1-3. Click Finish to create the plug-in project.

New Plug-in Project

Plug-in Content

"=rf -
Enter the data required to generate the plug-in. /

Plug-in Properties

Execution Environment: |JavaSE-1.6

Plug-in ID: [ch01 ]
Plug-in Version: [1.0.0 ]
Plug-in Narme: [cho1 Plug-in |
Plug-in Provider: [ ]

)

2 |Enyironments..

Plug-in Options

Generate an activator, a Java class that controls the plug-in's life cycle

Activator: [chOl.Activator

[[] This plug-in will make contributions to the UI
[7] Enable API Analysis

Rich Client Application

Would you like to create a rich client application? O

‘ = Back ” Next = H Finish H Cancel |:

Figure 1-3. Specifying plug-in content

The wizard builds the project, and then presents the plug-in manifest editor, as shown in
Figure 1-4. The two most important files are Activator.java and MANIFEST.MF.
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B &
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P =4 RE System Library [JavaSt-
b = Plug-in Dependencies
v @ src
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b [ Activatorjava
(= META-INF
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[ob build properties
P = Servers
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4 Overview

General Information
This section describes general information about this plug-in.

ID: cho1
version: 1.0.0
Name: Chol Plug-in
Provider:

Platform Filter:

Activator: ch0 1 Activator Browse. ..
Activate this plug-in when one of its classes is loaded

() This plug-in is a singleton

Execution Environments
Specify the minimum execution environments required to run
this plug-in.

=i JavasE-1.6 Add...

Configure |RE associations...

Update the classpath settings

ot %o @

Plug-in Content

The content of the plug-in is made up of two sections:

4 Dependencies: lists all the plug-ins required on this plug-
in's classpath to compile and run,

[ Runtime: lists the libraries that make up this plug-in's
runtime.
Extension / Extension Point Content

This plug-in may define extensions and extension points:

# Extensions: declares contributions this plug-in makes to
the platform.

[/ Extension Points: declares new function points this plug-
in adds to the platform

Testing
Test this plug-in by launching a separate Eclipse application:
2 Launch an Eclipse application
%5 Launch an Eclipse application in Debug mode
Exporting

To package and export the plug-in

-

. Organize the plug-in using the Organize Manifests Wizard

N

. Externalize the strings within the plug-in using the
Externalize Strings Wizard

specify what needs to be packaged in the deployable
plug-in on the Build Configuration page

4. Export the plug-in in & format suitable for deployment

@

Overview | Dependencies| Runtime Extensions Extension Points| Build| MANIFEST.MF | build properties

[ Problerns | Tasks = Properties | 4 Servers | ¥ Data Source Explorer | & Snippets El Console 52

Mo consoles to display at this time.

Figure 1-4. Plug-in manifest editor for this exercise

Creating the Plug-in

The activator class controls the life-cycle aspects and overall semantics of a plug-in. A plug-in
can implement specialized functions for the start and stop aspects of its life cycle. Each life-
cycle method includes a reference to a BundleContext, as follows:

public void start(BundleContext context) throws Exception {
super.start(context);

plugin = this;

log.info("Activator Start");

public void stop(BundleContext context) throws Exception {

plugin = null;

super.stop(context);

log.info("Activator Stop");

FOUNDATIONS OF ECLIPSE RCP
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BundleContext is a reference that contains information related to the plug-in and other
bundles/plug-ins in the system. Chapter 2 provides more information about the BundleContext
methods.

The Dependencies tab of the plug-in manifest editor is used to add references to other

bundles. You also need to add an extension point and implement the servlet, which you can
do through the Extensions tab of the editor.

1. To add references to other bundles, click the Dependencies tab, and then click the Add
button in the Required Plug-ins section. This displays the Plug-in Selection dialog, as
shown in Figure 1-5. For this exercise, add the following references, which are required
by the servlet extension point:

* javax.servlet
e org.eclipse.equinox.http.jetty
e org.eclipse.equinox.http.registry

e org.eclipse.equinox.http.servlet

n = = 8| 5= outlit
% Dependencies 0% 2O
Required Plug-ins 2 Imported Packages

Specify the list of plug-ins required for the operation of

Specify packages on which this plug-in depends without
this plug-in. explicitly identifying their originating plug-in.
% org.eclipse.core.runtime Add.. ‘ Add.. |
e javax.servlet (2.4.0) — \
% org.eclipse.equinox http jetty (1.1.0) |w| c
B B i
org.eclipse.equinax.hittp.reg [ uw | E B
|Proper‘t\es..‘|
=] Plug-in Selection ol[x

Select a Plug-in:

lcrg.echpse‘equm ]

- org.eclipse.equinox.app.source (1,1,0,v200804214 E
£ org.eclipse.eguinex.common source (3.4‘0‘v2008(IE|
- org.eclipse equinox.frameworkadmin (1.0.0.v2008
¥ org.eclipse equinox frameworkadmin.equinox (1.0
%= org.eclipse equinox frameworkadmin.equinox.sour
%= org.eclipse equinox.frameworkadmin.source (1.0.0
%= org.eclipse equinox http jetty.source (1,1.0.v2008(

=] = mB| - org.eclipse equinex http.registry.seurce (1.0.100.v
5

» Automated Management of Depend)|

% org.eclipse equinox.http.serviet source (1.0,100.v]

% org.eclipse equinox.jsp jasper [1.0.100.v20080427
Ovenview | Dependencies Runtime Extensicn; ?‘burg.echpae‘equmux‘

jspjasperregistry (1.0.0.v200¢
U T S SRR S SR 2

[&! Problems | ¥ Tasks = Properties | 4 servt [ u [ B

No consoles to display at this time. |

Figure 1-5. Adding dependencies
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2. Click the Extensions tab. Click the Add button and select the extension point
org.eclipse.equinox.http.registry.servlets. A servlet class name and alias will be
inserted automatically. The servlet alias (/servlet1) will be used to reference the serv-
let from a web browser. Internally, the XML for this extension point looks like this:

<?xml version="1.0" encoding="UTF-8"?>
<?eclipse version="3.2"?>
<plugin>
<extension

point="org.eclipse.equinox.http.registry.servlets">
<servlet

alias="/servlet1"

class="cho1.Servlet1">
</servlet>
</extension>

</plugin>

3. To implement the servlet class, click the class label link in the Extensions tab, as shown
in Figure 1-6. This launches the New Java Class wizard.

Note You can also implement a new class manually by adding the class name (cho1.Servlet1 in this

example) to the plug-in manifest editor, and then right-clicking the plug-in project folder and selecting New
» Java Class.

& % =8
% Extensions O % %@
All Extensions 4 B Extension Element Details

Define extensions for this plug-in in the following Set the properties of "servlet". Required fields are
section, denoted by "+,

type filter text

class*:

chol.sendetl iBrowse..‘ |
: [addo. | aliase:
+ <= org.eclipse.equinox.http.registrys - alias*: [servietl

@ y y \Re_r'r;;él httpecontextid:

load-on-startup:

Figure 1-6. Servlet extension point details

1
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4. Enter the class information, select javax.servlet.http.HttpServlet as the superclass,
and click Finish. The Java class will be created automatically.

5. Use the plug-in manifest editor to override the doGet method to return the headers of
the HTTP request to the browser, as follows:

@0verride
protected void doGet(HttpServletRequest req, HttpServletResponse resp)
throws ServletException, IOException
{
resp.setContentType("text/html");
dumpHttpHeaders(req, resp.getWriter());

}

@SuppressWarnings("unchecked")
private void dumpHttpHeaders(HttpServletRequest req, PrintWriter out)

{
out.printIn("URI:" + req.getRequestURI() + "<br/>");
Enumeration<String> names = req.getHeaderNames();
while (names.hasMoreElements()) {
final String name = names.nextElement();
out.println(name + "=" + req.getHeader(name) + "<br/>");
}
}

Testing the Plug-in

Now that you've created the plug-in, you can test it. You'll see that the OSGi console is very
useful for examining the OSGi framework and debugging missing dependencies.

1. From the main menu, select Run » Configurations to open the Run Configurations
dialog.

2. To create a new configuration under the OSGi framework, right-click and select New.
Make sure your plug-in is selected in the Bundles list, under Workspace, as shown in
Figure 1-7. You must also select all required bundles under Target Platform. To make
sure all required bundles are selected, unselect all bundles under Target Platform, and
then click Add Required Bundles. This will ensure only the required dependencies are
used at runtime. Then click Run.
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Create, manage, and run configurations %
Create a configuration to launch the 0SGi framework, KV-)JJ
S =
2 % = ﬂame:lch 01 ]
[:] i Bundles = Arguments | 27| Settings | & Tracing @ Environment | 1 Common
< [ Apache Tomcat Framewaork: | Equinox 2 Default Start level: EE| Default Auto-Start: ‘true G ‘
f Torncat vs .5 Server at lo
@ Eclipse Application [tYPE filer text ]
Ecl Data Tool F
&5 Eclipse Data Tools Bundles Start Level Auto-Start H Select Al
[ Generic Server
[ Generic server(External L ~ 6 ¥l Workspace Deselect All
 Generic Server(External Lar &
- <= cho1 (1.0.0) default default
[ HTTP Preview

B J2EE Preview
i Java Applet

I Java Application
Ju JUnit

< [=] %] Target Platform
[0 %= corn.ibrm.icu (3.8.1.v20080530)
%= corm.ibrm.icu.source (3.8.1.v200808
f” | [1%= corn jeraft jsch (0.1.37 w200B03061
Ju JUnit Plug-in Test
vl i g [] %= javax.activation (1.1.0 v200804101
< & 0SGi Framework N
[] = javax.mail (1.4.0 v200804091730)

S T —— ] %> javax.servlet (2.4.0v20080603160.  default default O Only show selected bundles

[~] 19 out of 655 selected

Add Required Bundles

| |
| |
«o cho1_fragment (1.0.0) default false | Addworking Set.. |
| |
| |

Restore Defaults

[ ¥ imvaw sandat isn (2 0 0 w20NRAAN2"

Include optional dependencies when computing required bundles

Add new workspace bundles to this launch configuration autormatically

[ validate bundles automatically prior to launching walidate Bundles
R ——r— B
Filter matched 14 of 14 items
@ l Run ] ‘ Close |

Figure 1-7. Run configuration dialog showing both the exercise plug-in (ch01) and the logging
fragment (ch01_fragment) discussed later in this chapter

3. Click the Arguments tab. Note the runtime arguments:
e os ${target.os}: The target operating system
e ws ${target.ws}: The target window system
e arch ${target.arch}: The target architecture
e nl ${target.nl}: Thelocale
* Console: Start the OSGi console; handy for investigating the state of the system
Also note the VM argument:

e 0sgi.noShutdown: If true, the VM will not exit after the Eclipse application has
ended; useful for examining the OSGi framework after the application has ended

When the plug-in runs, the console starts and is ready to receive user commands. This
is a handy tool to inspect the state of the system. From the following output, you can
see that Jetty started on port 80, which is the default in Windows.

13
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Note Under Linux environments, Jetty may fail to start on port 80, as ports lower than 1024 require
sysadmin access. In that case, add the VM argument -Dorg.eclipse.equinox.http.jetty.http.
port=8080 to start Jetty on port 8080.

osgi> Jun 21, 2008 6:21:10 PM choi.Activator start

INFO: Activator Start

Jun 21, 2008 6:21:10 PM org.mortbay.http.HttpServer doStart
INFO: Version Jetty/5.1.x

Jun 21, 2008 6:21:11 PM org.mortbay.util.Container start
INFO: Started org.eclipse.equinox.http.jetty.internal.Servlet25Handler@1a99561
Jun 21, 2008 6:21:11 PM org.mortbay.util.Container start
INFO: Started HttpContext[/,/]

Jun 21, 2008 6:21:11 PM org.mortbay.http.SocketlListener start
INFO: Started Socketlistener on 0.0.0.0:80

Jun 21, 2008 6:21:11 PM org.mortbay.util.Container start
INFO: Started org.mortbay.http.HttpServer@iea0252

osgi>

4. Point the browser to http://localhost/servlet1. You should see the output shown in

Figure 1-8.
/2 http:/ /localhost/servlet1 - Windows Internet Explorer =10 x|
@ v |¢1 http:;‘,l'lotalhost,l'sewbtlj 21X I'::.'L'=!|L' P~
| File Edit View Favorites Tools Help
e ke (& httpifflocalhostjserviet | |J - B - G @
URI/servletl
Accept="'%
Accept-Language=en-us
UA-CPU=x86

Accept-Encoding=gzip, deflate

User-Agent=Mozilla 4 0 (compatible; MSIE 7.0; Windows NT 5.1; NET CLR
2.0.30727; NET CLR 3.0.04506.648; NET CLR 3.5.21022)

Host=localhost

Connection=keep-alive

| [T T T T I3 meret % -

Figure 1-8. Output of the exercise
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Using OSGi Console Commands

The console is a handy tool to inspect your plug-in and identify problems. The following are
some of the most useful commands:

start [<id>|<name>]: Starts a bundle given an ID or symbolic name

stop [<id>|<name>]: Stops a bundle given an ID or symbolic name

install {URL}: Adds a bundle given a URL for the current instance

uninstall [<id>|<name>]: Removes a bundle given a URL for the current instance
ss: Lists a short status of all the bundles registered in the current instance

help: Shows information about all available commands

For example, to look at all the registered bundles, use the ss command, as follows:

0sgi> ss

Framework is launched.

Id State Bundle

0 ACTIVE org.eclipse.osgi 3.4.0.v20080605-1900

1 ACTIVE org.eclipse.osgi.services 3.1.200.v20071203

2 ACTIVE org.eclipse.core.jobs 3.4.0.v20080512

3 RESOLVED cho1_fragment 1.0.0
Master=12

4 ACTIVE org.mortbay.jetty 5.1.14.v200806031611

5 ACTIVE org.eclipse.core.runtime.compatibility.auth 3.2.100.v20070502

6 ACTIVE org.eclipse.equinox.http.servlet 1.0.100.v20080427-0830

7 ACTIVE org.eclipse.equinox.registry 3.4.0.v20080516-0950
Fragments=16

8 ACTIVE org.apache.commons.logging 1.0.4.v20080605-1930

9 ACTIVE org.eclipse.core.runtime_3.4.0.v20080512

10 ACTIVE org.eclipse.equinox.http.registry 1.0.100.v20080427-0830

11 ACTIVE org.eclipse.core.contenttype 3.3.0.v20080604-1400

12 ACTIVE org.apache.log4j 1.2.13.v200806030600
Fragments=3

13 ACTIVE javax.servlet 2.4.0.v200806031604

14 ACTIVE org.eclipse.equinox.common_3.4.0.v20080421-2006

15 ACTIVE cho1_1.0.0

16 RESOLVED org.eclipse.core.runtime.compatibility.registry 3.2.200.v20070717
Master=7

17 ACTIVE org.eclipse.equinox.preferences 3.2.200.v20080421-2006

18 ACTIVE org.eclipse.equinox.app_1.1.0.v20080421-2006

19 ACTIVE org.eclipse.equinox.http.jetty 1.1.0.v20080425

0sgi>

15
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To start and stop your plug-in, simply use the bundle ID. (The bundle name can also be
used, but who wants to type such long names?)

osgi> stop 15

271770 [0SGi Console] INFO chol.Activator - Activator Stop
Jun 21, 2008 6:25:42 PM chol.Activator stop

INFO: Activator Stop

osgi> start 15

Jun 21, 2008 6:25:47 PM cho1.Activator start

INFO: Activator Start

277188 [0SGi Console] INFO choi.Activator - Activator Start

Using Logging Services

Enabling a logging service within a plug-in is somewhat different from logging in a traditional

Java application. It is a bit trickier because of the dynamic component nature of the runtime.
To enable log4j in a traditional Java application, for example, the developer would create a

log47j.properties file in the project classpath, and then use statements such as the following:

// Log4] Logger
private static final Logger logger = Logger.getlogger(Activator.class);

public void start(BundleContext context) throws Exception {
super.start(context);
plugin = this;

logger.info("Activator Start");

However, putting log4j.properties in the plug-in class will not work, because the OSGi
framework manages a per-bundle classpath. It returns this message:

log4j:WARN No appenders could be found for logger (choil.Activator).
log4j:WARN Please initialize the log4j system properly.

The solution is to have the plug-in find log4j.properties in the classpath at runtime and
use it. However, this is a little tricky. One way to handle this is to create a plug-in fragment and
set the host plug-in ID to org.apache.log4j, as shown in Figure 1-9. This fragment will have a
log4j.properties file at the main level. Then, at runtime, the fragment will attach itself to the
log4j bundle classpath, thus finding the required log4j.properties file. The fragment must
also be included in the run configuration for the plug-in.

Note Fragments are separately packaged files whose contents are treated as if they were in the original
plug-in archive file. They are useful for adding plug-in functionality, such as additional language translations,
to an existing plug-in after it has been installed. Fragments are discussed further in Chapter 2.
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= New Fragment Project o [x
Fragment Content e
Enter the data required to generate the fragment. L
Fragment Properties

Fragment ID: IchOl_fragment
Fragment YVersion: Il.O‘O

Fragment Provider: I

Fragment Name: [ChOl_fragment Fragment ]
Execution Environment: |javaSE—l.6 g ‘

o | ‘Eny\runments.‘

Host Plug-in

Plug-in ID: [org‘apache‘logﬂj H Browse... ]

Minimum ‘Version: [1‘2.13 I ‘\ncluslve 3 ‘

Maximum Version: [ I ‘ Exclusive 3 ‘

@ ‘ < Back ‘ | Finish H Cancel ‘

Figure 1-9. Attaching a log4j.properties to the log4j bundle at runtime using a fragment

Here is the procedure to create the fragment for this example:

1. From the Eclipse IDE main menu, select File » New » Other » Plug-in Development
» Plug-in Fragment.

. In the New Fragment Project dialog, enter the plug-in information as shown in
Figure 1-9. Make sure the host plug-in points to org.apache.log4j. You can click the
Browse button to find and select that plug-in ID. Then click Finish.

In the fragment folder, add a 1log4j.properties file with the log configuration shown
in the following fragment. To add a text file, right-click the fragment folder and select
New » File. Make sure the file name is 1log4j.properties.

# Set root logger level to debug and its only appender to default.
log4j.rootLogger=debug, default

# default is set to be a ConsoleAppender.
log4j.appender.default=org.apache.log4j.ConsoleAppender

# default uses PatternLayout.

log4j.appender.default.layout=org.apache.log4j.PatternLayout
logaj.appender.default.layout.ConversionPattern=%-4r [%t] %-5p %c %x - %mkn
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This technique should enable the log4j logging service in your plug-in. However, if this
seems too complicated, a simpler way is to use the Commons Logging service within the main
plug-in, using this code:

// Commons Log
private static final Log log = LogFactory.getlLog(Activator.class);

public void start(BundleContext context) throws Exception {
super.start(context);
plugin = this;
log.info("Activator Start");

This fragment is much simpler; however, it will use the default Java logging service, which
I personally dislike. It is up to you to choose the logging service that best fits your needs.

USING THE ECLIPSE 3.4 SOFTWARE UPDATE MANAGER

The Eclipse 3.4 (Ganymede) distribution does not ship with a log service such as Apache log4j or Commons
Logging. However, the new Software Update Manager can be used to quickly discover and install software,
including logging plug-ins.

To use the Software Update Manager, from the Eclipse IDE main menu, select Help » Software
Updates. In the Software Updates and Add-ons dialog, click the Available Software tab. From here, you can
search for and install the Jakarta log4j and Commons Logging plug-ins.

& Software Updates and Add-ons

Installed Softwars

|I0g

Mame ‘Wersi
E | Garymeds Update Site
[=l [J V00 Testing and Perfarmance
=/ TPTP Log and Trace Analyzer 4.5.0
El Ul Uncategorized
=+ Apache commons logging 4.4.0
<+ Apache Jakarta log4j 4.4.0
[0/ Generic Log Adapter Authoring 4.5.0
[0/ Generic Log Adapter Authoring - Extension Point 1 4.5.0
D =[» Generic Log Adapter Runtime 4.5.0
[O=/* Log Analysis Core 4.3.2
[=)* Log Support 4.5.0
M1 =0 1 an Sinnnet - Frkensinn Point Tnstanres 4.5

This concludes the exercise in this chapter. The goal of this exercise has been to provide
an introduction to the power of the OSGi console and the basic plug-in life cycle, using a sim-
ple Jetty servlet extension point to listen for HTTP requests.
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Summary

This chapter introduced Eclipse RCP. The following are the important points to take away
from this chapter:

In today’s heterogeneous software world, there is a quest for openness and extensibil-
ity. A platform that addresses interoperability challenges and supports collaboration is
of critical importance.

Eclipse provides a consistent feature set on multiple platforms. It allows developers to
concentrate on the problem at hand, rather than the details of the specific platform.

The plug-in architecture makes it possible for Eclipse to support many programming
languages and development paradigms.

Eclipse is open source, free, and fully supported.
Eclipse is designed to be extensible and configurable.

Eclipse is at the forefront of the software tools industry. This means that you can
depend on it as a viable, industrial-strength tool for the foreseeable future.

The foundation of RCP includes Equinox, the core platform, SWT, JFace, and the
Eclipse workbench.

e Equinox is an implementation of the OSGi framework, a dynamic component
model for remote component management. This is something that is missing in
stand-alone JVM environments.

¢ The core runtime implements the basic plug-in model based on extension points
declared in XML in a manifest file (plugin.xml). The extension model provides a
structured way for plug-ins to describe the ways they can be extended, and for cli-
ent plug-ins to describe the extensions they supply.

e SWT is a GUI toolkit with fast native access to multiple platform widget sets, pro-
viding a common API. It is designed for performance, native look and feel, and
extensibility.

¢ JFace is a window-system-independent GUI toolkit for handling many common
programming tasks. It implements text, dialog, preference, and wizard frameworks,
as well as actions and data viewers.

¢ The workbench is the basic development environment in the Eclipse universe. It is
divided into perspectives, viewers, editors, workspaces, and projects.
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